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Chapter 1

Tips

1.1 PageStream3® Tips

Choose which type of tips to read, and then use the Next gadget to read

each tip in that section. When you come to the end of a section, it will

automatically start the next section.

Setup Tips

General Tips

Editing Tips

Layout Tips

Printing Tips

Import/Export Tips

Text Tips

Interface Tips

PageLiner/BME Tips

PageStream2 Upgrade Tips

Professional Page® Tips

Amiga Tips

DTP Definitions

Design Tips

Cookies

If you have AmigaDOS 2.0 or 2.1, you will have to scroll right to read

the tips. Sorry, AmigaGuide for these versions of AmigaDOS is unable to

wordwrap the tips.

Some of the tips will not appear correctly in AmigaGuide or Multiview

when using Topaz 8 or other AmigaDOS fonts. The Tips list in PageStream3

uses the SoftLogik 8 font which has special characters that are not

present in other AmigaDOS fonts.
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1.2 Setup Tip

To find out which version of a PageStream file you have installed, choose Macros/Tech Report or:

1. Open a shell.

2. Change to the directory containing the file. ie: CD SOFTLOGIK:FILTERS.

3. Check its version number. ie: VERSION IFFILUS.FILTER FULL. AmigaDOS will report something like: "IFFILUS 1.0
(4.15.94)"

Version numbers are important for determining if you have the latest filters, drivers and other modules and for reporting problems
to technical support. Addition modules and improved versions of modules are regularly uploaded to the Soft-Logik BBS, GEnie
CompuServe and Portal.

1.3 Setup Tip

If your objects are half as tall as they should be, you need to change your display resolution. Choose the Settings/Screen
command. Change the Display DPI to X:65 Y:55 for most NTSC monitors (North America), or X:65 Y:70 for most PAL
monitors (other continents).

If your objects are twice as tall as they should be, you probably have it set to X:65 Y:55 (NTSC) or X:65 Y:70 (PAL) when it
should be set to X:65 Y:27 (NTSC) or X:65 Y:35 (PAL).

To set the Display DPI accurately, you should measure the size of your screen display with a ruler (in inches). Divide this by the
display size in pixels to calculate the horizontal and vertical Display DPI. (i.e., 640 pixels ÷ 9.5 inches = 67 dpi)

Refer to page 483 of the manual for more information. (Note that the 75x75 dpi recommendation for PAL on page 484 is
incorrect. It should read 65x70.)

1.4 Setup Tip

Do not use the Times or Triumvirate fonts in your Fonts:_bullet_outlines directory with PageStream3. These fonts do not have
the same character widths and spacing values as the fonts that are included with PageStream3.

The fonts included with Workbench are Agfa’s CG series fonts. They modified these to create the CS series fonts, which are
included with PageStream3, so that the fonts could be used properly with PostScript printers.

If you want to add the fonts in the Fonts:_bullet_outlines directory to PageStream3 with the Settings/Fonts command, remove the
CGTimes.type and CGTriumvirate.type files from it and copy the files ending with ".type" from the PageStream3:Fonts/Intellifonts
directory to the Fonts:_bullet_outlines directory. Update the PageStream3:Fonts/Intellifonts directory and add the Fonts:_bullet_outlines
directory to it with the Settings/Fonts command, so that PageStream will know that the font files have been moved.

1.5 Setup Tip

If you’re extremely low on memory, type `REFRESH SIMPLE’ into your PageStream3.prefs or BME.prefs files (without quota-
tion marks). Use PageLiner or another text editor to do this.

The REFRESH SIMPLE option does not retain the contents of the windows below the current window or requester. This means
that lower windows must be redrawn whenever a top window or requester is closed or moved. This slows down the display
somewhat, but conserves memory.

It is the opposite of the REFRESH SMART option which is the default.
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1.6 Setup Tip

If you want PageStream to remember the position of the palettes, toolbox and document window when you next use the program,
choose the Settings/Snapshot Display command to make it memorize your setup. The position and size of all palettes and the
toolbox will be saved. The position and size of the current document window will be saved as the default for all document
windows.

1.7 Setup Tip

If you’re low on memory and you don’t use PANTONE® colors, remove the four PANTONE libraries from the SoftLogik:Colors
directory. These files are loaded automatically when you start PageStream and take up 100K of memory.

Removing the color libraries will also speed up the loading of PageStream.

1.8 Setup Tip

PageStream’s default page size is US Letter (8.5x11"). If you want to change this to another size, choose the Project/New
command, set the values to the desired defaults, and then choose the Settings/Save As Default command from the requester’s
menu. (Hold down the right mouse button while the requester is open.)

Most other defaults are set with the normal Settings menu commands.

1.9 Setup Tip

To set the default number of columns in a text column frame drawn with the Column tool, choose the Settings/Toolbox command
while holding down a Shift key. The default number of columns in frames created by the Layout/Create Columns command is
dependent on the column guides for the master page used for the current page. (The default master page and its column guides
are set when you create a new document.)

1.10 Setup Tip

If you want to open more than one copy of PageStream at once, you must set a different ARexx portname for the second copy.
When you run PageStream, it searches for the portname in the PageStream3.Prefs file. If it finds that the port is already active, it
brings its screen to the front rather running a second copy.

To start a second copy of PageStream after the first has been started, load the PageStream3.prefs file into a text editor and change
the 1PORTNAME PAGESTREAM2 to a different portname. i.e., 1PORTNAME PAGESTREAM.12 Now you can run a second
copy of PageStream3.

NOTE: The ARexx scripts included with the program have been written to work with the 1PAGESTREAM2 portname. If you
change the portname and wish to use one of the ARexx scripts with it, you must alter them before use.

VERY IMPORTANT NOTE: The Compugraphic font engine used in PageStream is licensed from AGFA. It cannot be used in
more than one copy of PageStream simultaneously. For example, if one copy was printing and therefore accessing the Compu-
graphic font engine, and another copy was rendering text on the screen, and using the engine at the exact same moment, both
programs will fail. If you want to use more than one copy of PageStream at once, do not use Compugraphic fonts! Sorry, there
is nothing that can be changed in PageStream to prevent this from happening.

1.11 Setup Tip

HotLinked files created with HotLinks 1.0 and 1.1 cannot be subscribed to in PageStream3, BME 2.0 or PageLiner 2.0 because
a new system is used. To get these files into the new programs, subscribe to them in the old versions, and then save or export the
data as ASCII text or IFF ILBM pictures, as applicable. Now you can load the data into the new versions.
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1.12 Setup Tip

If you’re low on memory or want to speed up the loading of PageStream, you may wish to consider removing filters that you do
not use from the SoftLogik:Filters directory. Refer to the manual and online help system for descriptions of the filters if you are
unsure what they are used for.

NEVER delete the IFFCTXT, IFFFTXT, IFFILBM, IFFILUS, IFFDR2D, IFFDOC or EPS filters.

If you’re only going to cut and paste inside PageStream3 and do not need to export drawings as IFFDR2D or text as IFFFTXT,
you can delete these filters. If you want to cut and paste text between programs, you should not delete the IFFFTXT filter which
is used by several word processors. If you want to cut and paste drawings between programs, you should not delete the IFFDR2D
filter which is used by TypeSmith and ProVector.

If you do not need to load PageStream 1 or 2 documents, you can delete the PageStream2 filter. If you do not need to load
ProPage documents, you can delete the ProPage filter.

You should quit PageStream before removing filters from the SoftLogik:Filters directory.

1.13 Setup Tip

To set the default grid spacing, choose the View/Set Grid command, set the values to the desired defaults, and then choose the
Settings/Save As Default command from the requester’s menu. (Hold down the right mouse button while the requester is open.)

Most other defaults are set with the normal Settings menu commands.

1.14 Setup Tip

The Settings/Save Settings command only saves Settings menu options. If you change an option in the View menu, such as Show
Grid, that change will not be saved when you choose the Save Settings command. Use the Settings/View command to save the
status of View menu options.

1.15 Setup Tip

You can run an ARexx macro automatically when you load PageStream3 and BME2. Load the PageStream3:PageStream3.prefs
file into a text editor such as PageLiner2. Add a new line using the following syntax:

STARTUP macroname

For example, if you wanted to run the PageStream3:Macros/ProjectSetup.rexx macro each time you started PageStream3, you
would type:

STARTUP PageStream3:Macros/ProjectSetup.rexx

1.16 Setup Tip

If you cannot use the Navigator after the tip appears when you first start PageStream3, and are using the public domain QMouse
utility, you should disable QMouse. On some systems, QMouse has been found to cause delays when using PageStream3 and
BME2.
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1.17 Setup Tip

PageStream3 copies objects to the clipboard as a CAT (dual-format) file. The objects are stored in IFF ILUS (used by PageStream3
to maintain all object types and attributes) and IFF DR2D (for compatibility with TypeSmith and the handful of other pro-
grams that support IFF DR2D in the clipboard). Copying both formats is slower than copying just the IFF ILUS required by
PageStream3. If you don’t need DR2D clipboard compatibility, you can disable it and copy just ILUS to the clipboard. You will
still be able to paste IFF DR2D files from the clipboard, but you will no longer copy the redundant IFF DR2D format to it.

Type `COPYDR2D FALSE’ into your PageStream3.prefs file (without quotation marks). Use PageLiner or another text editor to
do this.

1.18 Setup Tip

You can make PageLiner open on the PageStream3 public screen (or any public screen) by adding an entry to the PageLiner.prefs
file in the PageStream3: directory. Load this file into a text editor and add `PUBSCREEN=screenname’ to it. For example,
`PUBSCREEN=pagestream3’.

If you do not currently have a PageLiner.prefs file, create a new text file and make the first line read `;PageLiner Preferences file’.

1.19 General Tip

To move the page within a window:

1. Hold down the Right Amiga key.

2. Drag the page with the left mouse button.

Alternatively, drag the page with the middle mouse button of a three button mouse without holding down a key.

1.20 General Tip

Using a modem for technical support is a cost-effective means of getting your questions answered. You can post a question and
receive a reply within a day or even a few hours. Patches to the latest version of PageStream3 are made available online for you
to download.

We recommend the GEnie network for technical support. Soft-Logik technical support representatives answer questions on
GEnie each business day.

If you are not a GEnie user and you live in the USA or Canada, here is how to join:

1. Set your communications software for half duplex (local echo) at 2400 baud; up to 14400 baud access is available after you
signup at no extra charge.

2. Dial toll free: 1-800-638-8369 in the United States or Canada. Upon connection, enter HHH.

3. Enter JOINGENIE at the prompt and then press Return.

4. When asked for your special offer code, enter DHD524 and then press Return.

5. Have a major credit card ready. In the United States, you may also use your checking account number. (There is a $2.00
monthly fee for all checking accounts.) In Canada, VISA and MasterCard only.

For more information, call 1-800-638-9636 from 9am to midnight Eastern time, Monday to Friday, and from noon to 8pm on
Saturday or Sunday.

Once you have logged on to GEnie as a validated member and are at the top prompt, type SOFTLOGIK (or move 385).

If you do not have access to GEnie, Soft-Logik also provides technical support on CompuServe (type GO AMIGAVEN), Portal
(type GO SOFTLOGIK), Internet (email tech@slpc.com or post in the comp.sys.amiga.applications newsgroup) and on our own
BBS (dial 314-256-8971). Soft-Logik Publishing recommends GEnie as the best way to get technical support.
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1.21 General Tip

If you change the view magnification and want to switch back to the previous magnification, hold down a Shift key and click on
the Custom Scale button in the document window toolbar (the button showing the current view magnification). This will switch
to the previous used magnification without opening the Custom Scale requester.

1.22 General Tip

If you move to a new page and want to switch back to the previous page, hold down a Shift key and click on the Go to Page
button in the toolbar. This feature allows you to toggle between two pages without having to open the Go to Page requester.

1.23 General Tip

The name shown in the title bar of each window is the document name and the view name. The document name can be changed
when you first save the document, or when you choose the Layout/Edit » Document command. The view name defaults to
View.1, unless you open more than one view. Subsequent views are named View.2, View.3, etc. You can change the name of a
view by holding down a Shift key while you choose a view name from the Project/Reveal submenu.

1.24 General Tip

AmigaDOS 2.0 and 2.1 users: Unfortunately, keyboard equivalents which do not use the Right Amiga key cannot be shown in
the menus with versions of AmigaDOS prior to 3.0. The Type menu commands use Ctrl key equivalents and the Object menu
commands use single key equivalents. Refer to appendix D in the manual for a list of these keyboard equivalents.

1.25 General Tip

If you use the bitmapped fill patterns in the Line/Fill requester, you’ll notice that there are some solid black ones at the end of the
list. Soft-Logik is looking for suggestions for these default fills. If you would like to suggest one or more, write it down using
ones for the black dots and zeros for the white dots and send it to us, marked to the attention of Product Development.

1.26 General Tip

If you should need to force a screen redraw, choose the Macros/Redraw Window macro command. This will cause the entire
screen to be recalculated and redrawn. This macro command is included in the default macro list and can be executed by pressing
F10 unless you have changed it.

1.27 General Tip

Not sure which font to use? Use the Macros/Print Font Specimens macro to print a sample of each of your fonts. Put all of them
together in a binder for a useful reference. This macro requires ARexx.

1.28 General Tip

If you have any problems with PageStream, you should first check the online help system for last minute changes and for
answers to common questions. Click on the Help gadget to open the main help contents screen, and then click on the Last Minute
Changes gadget to see a list of known problems. Click on the Troubleshooting gadget in the main help contents screen to access
the troubleshooting section.
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1.29 General Tip

To move quickly to a page’s master page, choose the Macros/Go to Master Page macro command. (This requires ARexx.) To
move back to the page, choose the command again (or hold down a Shift key and click on the Go to Page button in the toolbar).

1.30 General Tip

To read about last minute changes in this version of PageStream3, choose the Macros/View ReadMe.Now File command. (This
requires ARexx.)

1.31 General Tip

Manual Errata: if you haven’t done so already, you should check the manual errata section of the help system and update your
manual. Click on the Help gadget to open the main help contents screen, and then click on the Manual Errata gadget.

1.32 General Tip

If you need to print form letters, order Datastore from Soft-Logik (USA and Canada) or Digita (other countries) and use the
Macros/Mail Merge macro. This will print form letters (or any other type of document) for each name and address (record) in
your database.

1.33 General Tip

Using a small monitor? You can get more space for your document by overlapping the screen’s title bar with your document
window. With Topaz 8 menus, there are 11 extra pixels at the top of your screen.

To change your default window setup, create a new document and position and size it as desired. You may want to move the
toolbox to the right side of the screen so that the screen’s depth gadget will still be available when the window overlaps the title
bar. When you have it set up correctly, choose Settings/Snapshot Display. Now you’ll have an extra 11 pixels of vertical space.

Note: do not use the Show Memory, Date and Time options in Settings/Screen if you plan to do this, because their window will
overlap the document window, creating a messy appearance.

1.34 Editing Tip

Work with the Edit palette visible to see and change the coordinates of objects; however, the Edit palette slows down the program
so you may want to close it for a more responsive feel.

1.35 Editing Tip

Toggle on the View/Snap-to-Grid command to draw, move and scale objects in increments of the grid spacing. This makes it
easy to align objects.

1.36 Editing Tip

If you need to make a copy of a complex object such as a picture, use the Object/Duplicate command instead of Edit/Copy and
Edit/Paste. Copy and Paste use the Amiga clipboard which is relatively slow compared to the fast Duplicate command.
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1.37 Editing Tip

Hold down a Shift key while scaling (resizing) an object to constrain changes to the object’s current aspect ratio. The aspect ratio
is the horizontal to vertical ratio of the object. Distorting the aspect ratio will change the appearance of the object and not just its
size.

1.38 Editing Tip

To set how much the object coordinate arrow gadgets in the Edit palette nudge the position and size of objects, change the Nudge
amount with the Settings/Drawing command.

1.39 Editing Tip

There are two ways to drag objects with the Object tool. If you press the mouse button and hold it down until AFTER the mouse
pointer changes to a 4 way arrow before moving the mouse, the actual outlines of all the selected objects will be shown as you
move them. If you press the mouse button and move the mouse BEFORE the mouse pointer changes to a 4 way arrow, just the
bounding box of the selected objects will be shown.

Dragging objects with just their bounding box visible is very fast. Dragging objects with their actual outlines visible will be
slower (depending on the complexity and number of objects selected), but allows for more precise placement. Choose the
method which best suits your needs.

1.40 Editing Tip

To select an object behind another object:

1. Hold down the Ctrl key.

2. Click over the object.

1.41 Editing Tip

When moving, scaling or drawing, you can press the right mouse button to cancel the operation.

1.42 Editing Tip

Undocumented Feature! Shape frames can contain multiple columns (the manual says they can’t). Just hold down a Shift key
while choosing the Text Frame command to set the number of columns in a shape frame.

1.43 Editing Tip

There are two ways to resize objects with the Object tool. If you press the mouse button and hold it down until AFTER the mouse
pointer changes to a 2 way arrow before moving the mouse, the actual outlines of all the selected objects will be shown as you
resize them. If you press the mouse button and move the mouse BEFORE the mouse pointer changes to a 2 way arrow, just the
bounding box of the selected objects will be shown.

Resizing objects with just their bounding box visible is very fast. Resizing objects with their actual outlines visible will be slower
(depending on the complexity and number of objects selected), but allows for more precise placement. Choose the method which
best suits your needs.
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1.44 Editing Tip

To paste an object at its original position rather than the center of the window, hold down a Shift key while choosing Paste.

1.45 Editing Tip

PageStream3 text gadgets support simple math expressions. You can add, subtract, multiply and divide values. This is most
useful when you want to add or subtract an amount to an existing coordinate. For example, to add 0.333 to a box’s left coordinate
of 8.125", you would enter 8.125"+0.333. When you pressed Tab or Return, the expression would be evaluated. Use + for
addition, - for subtraction, * for multiplication, and /for division. As well, () may be used for parenthetical expressions and `pi’
can be entered to represent the standard value of pi. i.e., 8.125*(pi-0.333)/7

1.46 Layout Tip

PageStream3 lets you create more than one column in a text column frame, which is very different from PageStream 2.x and
Professional Page®. This is useful because if you decide to change the number of columns in your layout, you can simply select
a text column frame and choose Object/Edit to change the number of columns in it. The text will reflow automatically. If you
had created independent frames for each column, you would have to resize them, add or delete column frames, and reflow the
text manually.

1.47 Layout Tip

To change the size of the current page you must change the size of the master page on which it is based. Click on the Edit
Master Page button button in the toolbar (the button with the white box and the gray box behind it) to open the Edit Master Page
requester. Enter the new page size and click on Ok.

Note that this will change the size of all pages based on this page. If all the pages in the document are based on the same master
page (they are all based on the Default Master Page unless you specify otherwise), this will change the size of all the pages.

If you want to change the size of the current page only, create a new master page with the Layout/Document Structure command,
then choose the Edit Page button in the toolbar (the white box button to the left of the Edit Master Page button) and choose the
new master page from the Master Page popup.

1.48 Layout Tip

You can move the rulers to position them next to the objects you want to measure. To move the rulers, hold down a Shift key and
drag from the ruler origin (the box where the rulers meet). Release the mouse button when the rulers are at the desired position.

To reset the ruler position to the top left corner of the page, hold down a Shift key and click on the ruler origin.

1.49 Layout Tip

You can move the zero point of the rulers to another position if you don’t want the page coordinates to be numbered from the top
left corner. To move the ruler zero point, drag from the ruler origin (the box where the rulers meet). Release the mouse button at
the desired position.

To reset the ruler zero point to the top left corner of the page, click on the ruler origin.

You can also change the ruler measurement direction. Hold down a Shift key while choosing the View/Show Rulers command
to open the Show Rulers requester.
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1.50 Layout Tip

If you can’t see the grid or guides because they’re obscured by objects, hold down a Shift key and choose View/Show Grid or
Show Guides, as appropriate, to open a configuration requester. If the color of the grid or guides matches that of your objects,
you can also change the color of the grid and guides with these requesters.

1.51 Printing Tip

PostScript users: If you cannot find a PPD file to match your PostScript printer (when you click on the question mark gadget next
to the PPD text gadget in the Printing Preferences requester), you should:

1. Check your PageStream master disks. Run the installer again and install just the PPD files. Now check for the correct PPD
file.

2. Check the disks that came with your printer. Most PostScript printers come with PPD files. (Check the DOS/Windows disk if
your printer came with one.)

3. Use a modem to call the Soft-Logik BBS or GEnie. Soft-Logik maintains a library of the latest PPD files in its libraries.

4. Try using the AppleLWriterPlusv38.0 file. Most PostScript laser printers are Apple LaserWriter Plus compatible.

5. As a last resort, use the .General file. This will not take advantage of special features of your printer, but will work for any
PostScript device.

Note: PageStream3 is compatible with version 4.0 and above PPD files. You can determine the version of a PPD file by loading
it into a text editor and searching for the "*FormatVersion" line.

Soft-Logik offers a two disk set containing almost 350 PPD files for $10.

1.52 Printing Tip

If you create a landscape document, you must remember to choose Landscape from the Orientation option in the Printing Pref-
erences requester before printing it. This is different from previous versions of PageStream which automatically rotated the
document to fit the paper.

For example, if you create a landscape US letter page (11 x 8.5"), you should choose US letter and Landscape in the Printing
Preferences requester.

1.53 Printing Tip

PostScript users: The Times and Triumvirate (PostScript name is Helvetica) fonts you use with PageStream have many more
characters than the fonts resident in a PostScript printer. Sorry, but these characters cannot be printed on a PostScript printer. If
you use these characters, they will not print. Refer to appendix A of the manual for a list of the characters in most PostScript
fonts.

1.54 Printing Tip

PostScript users: When PageStream3 downloads a Compugraphic font to a PostScript printer, it generates a PostScript PFB file
from the Compugraphic font. The PFB file is downloaded to the printer because Compugraphic fonts cannot be sent directly to
a PostScript printer.

The process of converting a Compugraphic font to PFB is very slow, so it is not practical to do this every time you print a
Compugraphic font to a PostScript printer. PageStream will save the PFB file to the same directory containing the Compugraphic
font, so that it will be available the next time you print the font. This dramatically improves printing speed on subsequent print
jobs.
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If you know you won’t be printing the font again for a while, you may delete the PFB file to save disk space. (The PFB files are
named with the Compugraphic font numbers.) As a point of interest, the PFB files are true PostScript font outlines that can be
used with another program supporting PostScript fonts. They cannot be used with PageStream other than for printing because
PageStream requires a matching metric file.

The PFB files won’t conflict with the Compugraphic fonts in the same drawer, because when PageStream examines the fonts in
the drawer it will realize that the PFB is just a derivative of the Compugraphic font.

Note that PFB files will not be created for Compugraphic fonts which are equivalent to the fonts resident in a PostScript printer.
If you print Times to a printer, a PFB file will not be created because the font already exists in the printer. The list of fonts
resident in your printer is contained in the PPD file you have chosen in the Settings/Printing requester.

1.55 Printing Tip

PostScript users: If you cannot get PageStream3 to print to your PostScript printer, the first thing to check is your selected PPD.
PostScript is a device independent language, but PPD files are very device specific.

If you have a Hewlett-Packard 4M Plus, for example, you should choose the HPLaserJet4-4MPlus600 file. If you mistakenly
choose the HPLaserJet4-4M600 (which is designed for the older Hewlett-Packard 4M printer), you will get a configuration error
when printing.

1.56 Printing Tip

If you are printing a PostScript file to disk for use with Post, the public domain PostScript interpreter, do not choose a PPD in the
Printing Preferences requester. Choosing a PPD will set options which Post is unable to handle.

1.57 Printing Tip

To print a masterpage so that you can check its layout, choose Range from the Pages popup gadget in the Print requester. Enter a
range of just # where # is the number of a blank page in the document. If the master page is double sided, ensure you choose an
even or odd numbered page number as appropriate.

1.58 Printing Tip

Thinking about buying a new laser printer? Soft-Logik recommends PostScript® compatible printers for use with PageStream.
PostScript printers are much faster than non-PostScript laser printers, often 10-20 times as fast.

PostScript printers also offer more control over halftone screens and can print EPS graphics. If you use an imagesetter for your
final output, a PostScript printer can save you many headaches by providing more accurate proofs.

New models of printers are always being released, and any true PostScript laser printer should work without problems. At the
time of this writing, two of the best current printers are the Hewlett-Packard 4M Plus (fast, large capacity 600 dpi) and 5MP
(home and small office 600 dpi).

1.59 Import/Export Tip

To export something as an EPS file:

1. Choose the Settings/Printers command.

2. Choose PostScript from the Type popup. Choose EPS file from the Send to popup. Click on Use.

3. Choose the Project/Print command. Set your options and click on Save.

4. A file requester will open to set the EPS filename. Enter the filepath and name and click on Save.
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1.60 Import/Export Tip

If you create a drawing in PageStream that you would like to use in more than one document, export it as a drawing. Select
the objects with the Object tool and then choose the Project/Export Graphic command. A requester will open to choose the file
format for the drawing. IFF ILUS is the best format to use.

After exporting the selected objects as a drawing, you can import the drawing whenever you need to use it in a document.

1.61 Import/Export Tip

Opening and saving documents with bitmap pictures is slower in PageStream3 than in PageStream2 because the pictures are
automatically compressed to save space in the document file. You can decrease the time required to open and save documents by
making all the pictures external to the document. Select each picture, choose Object/Edit, and check the Leave External option.

If the document was created in PageStream 1 or 2, you should export the pictures first (if you do not already have copies on
your hard drive) because PageStream will prompt you to select the external file to use when you check Leave External. This is
because PageStream 1 and 2 did not retain the filename and path of the picture. If the document was created with PageStream
3, checking Leave External will automatically search for the original file. If it is not found, then PageStream will prompt you to
select the file to use.

1.62 Import/Export Tip

PageStream allows you to render a page as an IFF ILBM picture. Click on the Settings gadget in the Print requester to open the
Printing Preferences requester. Choose the IFF ILBM printer driver from the Type popup menu gadget and then set the other
options as desired. Print each page individually.

1.63 Import/Export Tip

If you can’t ungroup a drawing after importing it, it’s because it’s a structured drawing object. Use the Object/Dissolve Drawing
command to edit it. (Drawings may still need to be ungrouped after dissolving, depending on whether the original graphic was
grouped.) Refer to pages 220 and 236 of the manual for more information.

1.64 Text Tip

1I set the tabs, but the tab positions didn’t seem to change.2

Tabs are a text attribute in PageStream3, not a column attribute like they were in previous versions. You must set the tabs before
you enter text, or select the text if it has already been entered, exactly as you would for any other text attribute. If you simply
place the insertion point in a paragraph and choose Tabs, you will set the tabs for the insertion point position only.

1.65 Text Tip

If you want to enter a non-AmigaDOS character into Paragraph Format’s Character text gadget, type a slash and its unicode
value. For example, to use the infinity symbol as a bullet, enter 1\087342 into Character.
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1.66 Text Tip

PageStream allows you to enter characters other than those in the AmigaDOS character set by typing mnemonics (Ctrl C short-
cuts) and Unicode values (Ctrl D shortcuts). Unfortunately, these cannot be used in requester text gadgets because those are
controlled by AmigaDOS and use an AmigaDOS font.

There are three important exceptions to this. If you want to enter a non-AmigaDOS character for a filled tab or custom alignment
(Tab requester), or for a bullet character (Paragraph Format requester), you can enter a backslash followed by the Unicode value
of the character. For example, to enter a pi symbol, enter `\960’ into the text gadget (without quotation marks). Leading zeros
are not required.

1.67 Text Tip

If you are using a script font, you should set the track table to None instead of Normal. Script fonts should generally be used
with no tracking.

1.68 Text Tip

To remove manual kerning from text, select the text and choose Manual Kern.

1.69 Text Tip

To change the attributes of a dot leader (filled tab), highlight the dot leader with the Text tool after it is entered, and then use any
of the Type menu commands to change its attributes. This is commonly used to change the font, size or type style of a dot leader.

1.70 Text Tip

If a text column frame has a ºª (overset) symbol at its bottom right corner, then there is more text in the frame than can be
displayed. You should link the frame to another column frame so that the overset text can be shown in another frame, make the
frame larger so that all of it can be displayed, or make the visible text smaller so that the overset text can be shown. It is possible
that the overset text may merely be extra linefeeds that you entered accidentally.

The overset indicator will not be printed, but you should watch for overset indicators to avoid creating documents with potentially
important `missing’ text. Refer to page 164 of the manual for more information.

1.71 Text Tip

You can force justify text in PageStream3 by setting the Last Line Flush Zone to be greater than the column width. This option
can be set with the Type/Tracking command. Forced justification justifies every line in a paragraph, including the last line.

1.72 Text Tip

You can left and right justify text on one line with a right indent tab. Enter the left text, press Tab while holding down a Shift key,
and then type the right text. Shift Tab will insert a right indent tab and will force the following text to be right justified.

You can also use this with a center aligned tab to make text left, center and right justified on one line. Enter the left text, press
Tab, enter the center text, press Shift Tab and then enter the right text. Then select the text and create a center aligned tabstop at
the center of the line length.
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1.73 Text Tip

To start a new line without starting a new paragraph, hold down a Shift key while pressing Return.

If you are using paragraph spacing, sometimes you may need to start a new line without starting a new paragraph. For example,
if you had a dual line signature block on your letters, you wouldn’t want to have extra space between the first and second lines.
Shift Return lets you do this.

1.74 Interface Tip

When there are more entries in a popup gadget than can be displayed on screen, you can scroll the entries in the popup list by
moving the mouse pointer to the end of the popup list in the direction you wish to scroll. Up and/or down arrows will appear to
indicate if there are additional entries.

If you move the mouse pointer over the up or down arrow, the entries will scroll one entry at a time. If you move the mouse
pointer outside of the popup list, the entries will scroll ten entries at a time.

If you’re using the Font popup gadget in the Edit palette and there are so many entries that it takes a long time to scroll, you
should consider using the Font palette instead. It has an option to view only the fonts in use in the current document.

1.75 Interface Tip

If you open multiple views of a document, choosing the Close command will only close the active view window. Hold down a
Shift key while choosing the Close command to close all open views of a document simultaneously.

1.76 Interface Tip

Hold down an Alt key while clicking on the Close gadget of a palette or window to collapse it. This is different from zooming
with the Zoom gadget, which merely toggles between two window sizes. Collapsing a palette or window reduces it to the height
of the title bar. This is an excellent way to leave all the palettes open without using up valuable screen real estate.

1.77 Interface Tip

Confused by checkbox gadgets with X’s in them, or list gadgets with <As Is> in them? Read page 25 of the manual to learn
about the indeterminate state of gadgets.

1.78 Interface Tip

Hold down a Shift key and click on the Next gadget in this Navigator requester to read the previous tip. Hold down the Ctrl key
and click on it to randomly select another tip.

The current tip number and the total number of available tips are shown in the upper right corner of this requester.

If the font for the tip numbers is the same as the font for the word `Tip’ in the upper left corner of the requester, your assigns are
not correctly set. The tip numbers and the tips themselves should be set in SoftLogik 8, which is a thin version of Topaz, while
the word `Tip’ is set in the standard Topaz 8 font. Add the following assign to your s:user-startup file:

assign fonts: softlogik:fonts add
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1.79 Interface Tip

Press the Esc key to exit any requester that has a Cancel gadget. Like pressing Return for the default gadget, the text cursor
cannot be in a text gadget when you press Esc. If it is in a text gadget, press Return to exit the gadget and then Esc to cancel the
requester.

1.80 PageLiner Tip

PageLiner 2.0 can load only ASCII text files. If you created IFF DTXT files with PageLiner 1.x and want to load them into
PageLiner 2.0, you can do one of two things:

1. Start PageLiner 1.x, and choose Edit/Select All and then Project/Save As ASCII. Start PageLiner 2.0 and load the ASCII file.
This will lose any formatting in the file.

2. Start PageStream3, insert the IFF DTXT file into a text column. Choose Edit/Select All and then Project/Export Text. Export
the text in ASCII format with the Text Codes option toggled on (if you want to preserve formatting) and load it into PageLiner
2.0.

1.81 PageLiner Tip

If you notice that you have lost some text attributes when using the Send to Editor command to edit text in PageLiner, its because
some text attributes do not have text code equivalents. Text codes are used to send text with attributes to PageLiner. For example,
gradient fills applied to text will be lost.

All basic text attributes can be expressed as text codes, although some of their options may not be definable in text codes, so
loss of attributes should be rare when sending body text to PageLiner. To prevent the loss of any text attributes, use style tags.
The style tags will be defined in PageStream, so when the text returns to PageStream, it will be reformatted with the style tags’
attributes.

1.82 BME Tip

If you trace a color picture with BME’s Effects/Trace command, white gaps can appear between the blocks of color when the
drawing is imported into PageStream. To fill these gaps, select the objects with the Object tool, choose the Object/ Line/Fill
command, and set the line width to 2 or 3 points. This will trap the gaps with the objects’ colors.

1.83 PageStream2 Upgrade Tip

PageStream2 users: The Mirror, Light, Double Underline and Strike Through type styles are missing from the Type Style
submenu in v3. Double Underline and Strike Through are now options for the improved Underline type style. Hold down a
Shift key while choosing Underline to select one of these options. Light was removed because it is easily duplicated with the
Line/Fill requester, and Mirror was removed because we found that it was rarely used. (Mirrored type is still supported via macro
commands.)

1.84 PageStream2 Upgrade Tip

PageStream2 users: Note that the Return key is not used to move between text gadgets in PageStream3. PageStream now closely
adheres to the Amiga interface style guidelines. Use the Tab key to move to the next text gadget, or Shift Tab to move to the
previous text gadget. Use Return to exit the active text gadget. Press Return a second time (when the cursor is not in a text
gadget) to choose the default exit gadget, if present. The default exit gadget is bolder than other exit gadgets.
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1.85 PageStream2 Upgrade Tip

PageStream2 users: Importing and pasting objects works differently in version 3. When you import a graphic or paste an object,
it is pasted immediately at the center of the window. While less convenient than the previous method in 2.2, this is more memory
efficient. You can move and scale the object immediately after pasting or placing.

1.86 PageStream2 Upgrade Tip

PageStream2 users: Copy and Paste work more slowly in version 3 than they did in previous versions because PageStream now
uses the standard Amiga clipboard instead of a fast internal buffer. While this is slower, being able to copy and paste between
applications more than makes up for the loss of speed.

1.87 PageStream2 Upgrade Tip

PageStream2 users: Ruler guides are now created with the View/Set Guides command rather than clicking on the rulers as in
version 2.2. This makes guides more accurate.

1.88 PageStream2 Upgrade Tip

PageStream2 users: Do not use the Times, Triumvirate or Garamond fonts from PageStream2 with PageStream3. New versions
of these fonts are provided. If you use the older fonts with PageStream3, some characters will not work.

1.89 PageStream2 Upgrade Tip

If you load a document created in PageStream 1 or 2 into PageStream3, all the text in the document will be set to Auto Kerning
Off, Auto Hyphenation Off, and Tracking None. These features did not exist in previous versions of PageStream so they must be
off to ensure that lines of text break as closely as possible to the way they broke in previous versions of PageStream.

You can improve the appearance of your text by setting Auto Kerning and Auto Hyphenation to On, and Tracking to Normal;
however, this will likely change the position of some line breaks and you may need to re-edit your document.

1.90 PageStream2 Upgrade Tip

If you have fonts from a previous version of PageStream that you want to use with v3, here’s how to add them:

1. Choose the Settings/Fonts command to open the Font Preferences requester.

2. Click on the Add gadget. A file requester will open.

3. Change to the directory containing the fonts you want to add. When you see the fonts listed in the file requester, click on the
Add gadget.

4. Click on Save in the Font Preferences requester to save this as your default font setup.

1.91 PageStream2 Upgrade Tip

PageStream2 users: Tabs are now created with the Type/Tabs command rather than by clicking on a bar at the top of each column
as in version 2.2. Not only does this make tabs more accurate, it allows you to apply different tabs to each paragraph.
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1.92 Professional Page® Upgrade Tip

If you are a former Professional Page® user, click on the Help gadget to open the main help contents screen, and then click on
the 1Professional Page® Feature Finder2 gadget for a list of ProPage commands and their PageStream equivalents.

1.93 Professional Page® Upgrade Tip

ProPage users: Add your CGfonts: directory to PageStream’s font list by choosing Settings/Fonts to open the Font Preferences
requester. Click on the Add gadget and choose CGfonts: from the file requester. Click on Add in the file requester. Now the
fonts you used with Professional Page can be used with PageStream. Note: If you do not want to use ProPage further, you can
move its fonts elsewhere and then add that path instead.

You must add your ProPage fonts if you wish to open your ProPage documents in PageStream3. If you do not have the same
fonts available, PageStream will have to substitute another font. You do not have to keep your Times and Triumvirate files from
ProPage if you will not use ProPage in the future, because PageStream also comes with those fonts.

1.94 Amiga Tip

Did you know that the file requester has an attached menu? Hold down the right mouse button to see it when opening or saving
files. One of the menu commands allows you to delete the file selected in the file requester.

Here are some more ASL (Amiga Standard Library) file requester tips:

You can create a drawer with the file requester by typing in the new drawer name when saving. For example, if you wanted to
save the file `MyDocument’ in the `Work:Documents’ directory, but the Documents drawer did not exist, type `Work:Documents’
into the Drawer text gadget of the Save file requester and press Return. This will bring up an alert asking you if you want to
create a new drawer. Click on Create to create the drawer. Now you can save the file as you normally would.

If you prefer to type the path and file names into the file requester, you do not need to type the drawer and file names in their
separate gadgets. For example, if you want to save `temp’ in `ram:’, just type `ram:temp’ into the File text gadget and press
Return twice. The file requester will sort it out for you.

These tips may not apply if you are using a file requester that replaces the ASL file requester.

1.95 Amiga Tip

If you find PageStream too slow, you may wish to upgrade your computer to improve its performance. A 68040 accelerator will
provide the biggest performance boost if you have a 68000 (A500, A1000, A1500, A2000), 68020 (A1200), or 68030 (A2500,
A3000, A4000-030). Even if you have a 68040 processor, there are some faster 040 and 060 boards that will improve the speed
of your computer.

PageStream does not use a FPU (Floating Point Unit) for its primary calculations, so adding one will have a minimal impact on
performance. PageStream uses integer math which is actually faster than floating point calculations with a FPU.

Other things you can do to improve performance are:

- Use PageStream on a screen with few colors. Working in 4 color mode is much faster than 16 color mode, or 256 color mode
on AGA machines. Use the Settings/Screen command to change the number of colors.

- Add additional memory. With one or two extra megabytes of memory, PageStream can work more efficiently and you can
create larger documents with more fonts and graphics. If you have 4MB or less, you can barely run PageStream3. 6MB is a more
comfortable minimum system.

- Add a fast hard drive. Hard drive speed is a small part of the performance equation, but older hard drives are very slow compared
to today’s models.
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1.96 Amiga Tip

If you find yourself double clicking accidentally in PageStream, decrease your double click timing by changing it with the
Sys:Prefs/Input program. Many people prefer a setting of 15. Amiga computers ship with a very high double click setting which
causes many accidental double clicks.

1.97 Amiga Tip

If you have an Amiga 2000 or 3000, consider purchasing a graphic board to increase the number of screen colors available to
PageStream. Non-AGA Amiga computers can display a maximum of 16 colors. With a graphic board such as the Picasso, Retina,
Piccolo or Spectrum, you can use PageStream in up to 256 colors. These boards offer 24 bit (16 million color) graphics, but
PageStream cannot operate on them in greater than 256 colors because they emulate Workbench in a maximum of 256 colors.

1.98 Amiga Tip

PageStream uses your Workbench interface colors for its interface. The bottom four colors are the primary colors. If you use
PageStream in greater than four colors, the top two colors are also reserved by Workbench, for a total of six reserved colors. Set
your Workbench to at least eight color mode, then choose Sys:Prefs/Palette to set these colors.

You cannot change the interface colors from within PageStream, and if you change your Workbench colors, you must reload
PageStream to use them because it checks your Workbench colors only when it is first loaded. If you open it on an existing
public screen, its interface colors will be determined by the colors of that screen.

If you have your Workbench set to colors that are not suitable for use in PageStream, you can change these colors by adding
entries to the PageStream3.prefs file in the PageStream3: directory. If you use AmigaDOS2, you should set colors 4 and 5 so
that your menus will be highlighted with reasonable colors.

To find out how to specify interface colors for PageStream3, click on the Help gadget to open the main help contents screen, and
then click on the Screen button.

PageStream uses the pen color allocation system of AmigaDOS 3+. If you use it on a public screen and find that the colors
change unexpectedly, remove the other programs running on that public screen because they are probably not AmigaDOS 3+
compliant. With AmigaDOS 2.0-2.1, PageStream uses its own pen color allocation code which is similar to AmigaDOS 3+.

1.99 Amiga Tip

MagicMenu users: If you try to Shift select a menu command that should open a requester when Shift selected, and the requester
does not open, you must change your Pop Up Menu option in the MagicMenu configuration requester from Press Once to either
Standard or Select.

1.100 Amiga Tip

AGA users: PageStream uses high resolution mouse pointers. If your system pointers are set to low resolution (the arrow pointer
and busy clock will be larger and jaggier than the other pointers in PageStream), you should change them to high resolution with
the Sys:Prefs/Pointer utility. Change its Resolution cycle gadget from Low Res to High Res and click on Save. The arrow pointer
and busy clock will now be smaller and will match the other pointers in PageStream.

High resolution pointers help you position the mouse more accurately. This feature is only available on Amiga AGA (A1200,
A4000) computers.
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1.101 Amiga Tip

Buying fonts for Amiga computers can be difficult because most fonts are packaged for Windows, DOS and Macintosh users.
Here are some general guidelines to follow when purchasing fonts:

1. Always buy DOS/Windows format fonts unless you have MAC2DOS or a similar utility that lets you read Mac format disks,
and are experienced in converting Mac format font files to DOS/Windows/Amiga format.

2. Always buy fonts that are labelled as PostScript fonts. If you have the PageStream3 TrueType engine (sold separately), you
can also purchase Windows TrueType fonts. (You can also convert Windows TrueType fonts to PostScript with TypeSmith.

3. PageStream requires a PFB and an AFM (or PFM) file for each font. If you are not sure that these files are included with the
package, do not buy it.

4. If you are in doubt, here are some brands of fonts that are definitely compatible:

Soft-Logik sells the Brendel Type (B&P) font CD-ROM with 1000 PostScript fonts for $499. It is also available on Syquest
cartridges at an additional charge. The CD-ROM may be used on Amiga, Macintosh and Windows computers, and its fonts are
also stored in TrueType format. 1-800-829-8608 (or 314-894-8608, fax 314-894-3280)

Adobe sells hundreds of font packages. While they are relatively expensive, Adobe’s fonts are excellent. Ensure you ask for
PostScript format on 720K PC disks (if you have a high density drive, you can use 1.4MB disks). 1-800-445-8787 (fax 408-655-
6073)

Image Club sells over 700 fonts in a variety of packages. Ensure you ask for PostScript format on 720K PC disks (if you have a
high density drive, you can use 1.4MB disks). 1-800-661-9410 (or 403-262-8008, fax 403-261-7013)

1.102 Amiga Tip

When you quit PageStream3, it returns all memory it used; however, libraries and AmigaDOS fonts that it opened remain open
and continue to consume memory. If you want to close these to regain the memory, you must type `AVAIL FLUSH’ in a shell.
(This is just the way the Amiga works.)

1.103 Amiga Tip

Stacking palettes on top of your document window can slow down PageStream due to the way the Amiga handles windows. Each
palette that overlaps the window will slow down PageStream by approximately 10%. Position the palettes beside the window
instead of on top of the window for full speed.

1.104 DTP Definition

Jump Line: text indicating to the reader that the article continues on a following page, or is continued from a previous page.

1.105 DTP Definition

Hairline: a thin typographic rule, usually 0.3pt or thinner.

1.106 DTP Definition

Dot leader: a row of dots connecting columns of information. i.e., tables of contents (sections and page numbers), menus (items
and prices). ex:
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Hamburger......$4.95

Pizza..........$7.95

Lasagna........$8.95

1.107 DTP Definition

Pull-quote: a short phrase extracted from the body of an article. Pull-quotes are usually set in a contrasting typeface and provide
additional entry points into articles.

1.108 DTP Definition

Bleed: the extension of the page layout beyond the physical border of the page. Use bleeds to avoid unwanted borders around
the layout, but be aware of the increased printing costs for bleeds.

1.109 Design Tip

Never use two or three hyphens as separators; use an em-dash (about the width of three hyphens) to enclose a parenthetic thought.
Type <Ctrl c m-> (without the angle brackets) to create an em-dash.

Wrong -> For complex documents---books, magazines and newsletters---use PageStream.

Correct -> For complex documents-books, magazines and newsletters-use PageStream.

The same is true for en-dashes, which are about the width of two hyphens. They are used to replace the word 1to2. Type <Ctrl c
n-> (without the angle brackets) to create an en-dash.

Wrong -> Mar--Apr 1994

Correct -> Mar-Apr 1994

(These examples simulate en and em-dashes because the Amiga character set lack these characters. True en and em-dashes are
not as wide as shown here and are present in the fonts included with PageStream.)

Note: Do not add spaces before or after an en or em-dash.

If you turn the Smart Dashes option on in the Settings/Typographic requester, PageStream will convert double hyphens to en-
dashes and triple hyphens to em-dashes as you type them.

Choose the Convert Dashes option when using the Project/Insert Text command to convert double and triple hyphens to en and
em-dashes.

1.110 Design Tip

Never type three periods for etcetera because the periods will be too close together.

i.e., Dogs, cats, birds¼

Always use a true ellipsis which will have properly spaced dots.

i.e., Dogs, cats, birds...

Type <Ctrl c ..> (without the angle brackets) to create an ellipsis.
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1.111 Design Tip

Never type two spaces between sentences-this is a holdover from the days of typewriters. Use single spaces to separate sentences.

If you have typed or imported text with double spaces between sentences, use the Find/Replace requester to search for and replace
double spaces.

1.112 Design Tip

These characters should always be followed by a space: @, ¶, · (bullet)

These characters should always be preceded and followed by a space: &, + - × ÷ < > (formula usage)

These characters should never be preceded or followed by a space: -, - (en dash), - (em dash)

These characters should never be preceded by a space: %, *, ¢, ° (degree)

These characters should never be followed by a space: $, #, ±, + - (positive/negative usage)

1.113 Design Tip

Don’t indent the first paragraph after a headline. First-line indents can be used for new paragraphs within an article, but not for a
paragraph following a headline.

1.114 Design Tip

Always use typographic quotation marks instead of typewriter quotation marks. Type <Ctrl c "l> (without the angle brackets) for
left or opening quotation marks, and <Ctrl c "r> (without the angle brackets) for right or closing quotation marks.

Wrong -> "I’m going to work," she said.

Correct -> 1I’m going to work,2 she said.

If you turn the Smart Double Quotes option on in the Settings/Typographic requester, the first quotation mark you type will be
converted to a left quotation mark, and the next will become a right quotation mark, etc.

Choose the Convert Quotes option when using the Project/Insert Text command to convert typewriter quotation marks to typo-
graphic quotation marks.

1.115 Design Tip

Don’t underline text to make it stand out because underlining makes text more difficult to read. Underlining is a holdover from
the days of typewriters which lacked other means to emphasize text. Instead, use a semibold or bold weight to attract attention.
Avoid overuse of bold weights, because too much scattered bold makes paragraphs look `blotchy’.

1.116 Cookie

1Duct tape is like the force. It has a light side, a dark side, and it holds the universe together.2 - Carl Zwanzig

1.117 Cookie

1Imagination is the one weapon in the war against reality.2 - Jules de Gaultier
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1.118 Cookie

Proverb: He who has no inclination to learn, is apt to think he knows enough.

1.119 Cookie

1Any sufficiently advanced technology is indistinguishable from magic.2 - Arthur C. Clarke

1.120 Cookie

1Violence is the last refuge of the incompetent.2 - Salvador Hardin
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